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Introduction 
 

COBie is the abbreviation of Construction Operations Building Information Exchange, a specification used in 
the handover of Facility Management information. It is a spreadsheet data format for the delivery of a subset 
of building model information, rather than geometric model information. 

Although GRAPHISOFT ArchiCAD cannot export COBie spreadsheets directly, ArchiCAD’s BIM-quality models 
and IFC data exchange capabilities produces data output that is easily converted into COBie documentation, 
with the help of free or commercial conversion programs. 

What is the relationship between IFC and COBie? 

The COBie spreadsheet is a mapping of the Basic FM Handover View Definition, which is a subset (so-called 
“Model View Definition”; MVD) of the current IFC 2x3 scheme. Basic FM Handover View Definition was 
developed by buildingSMART to exchange facility management information among building models. 
ArchiCAD 17’s IFC 2x3 interface and database support the IFC data and model export requirements of the 
Basic FM Handover View Definition, so most of the values of the COBie spreadsheet cells are extracted from 
IFC models exported by ArchiCAD 17 according to the Basic FM Handover MVD settings. 

Hint To read more information about the relation between IFC 2x3 Basic FM Handover MVD and COBie, 
visit the buildingSMART website by clicking here. 

This paper provides practical information on which data to add to an ArchiCAD project and how to export it 
as an IFC model, to obtain a format suitable for producing a COBie2 spreadsheet. (The current version of 
COBie is 2.4.) The final chapter consists of a sample workflow using a free IFC → COBie conversion tool 
recommended by buildingSMART. 

Hint For detailed documentation about ArchiCAD’s IFC capabilities, visit the GRAPHISOFT website by 
clicking here. 

Note This documentation was written based on the currently available COBie – IFC mapping rule called 
“Responsibility Matrix version 17” (published 30th April 2013). 

  

http://www.buildingsmart-tech.org/specifications/ifc-view-definition/fm-handover-aquarium/fm-aquarium-cobie2-description/fm-aquarium-cobie2-description
http://www.graphisoft.com/downloads/addons/ifc/index.html
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ArchiCAD Model Preparation for COBie2 
 

The Basic FM Handover View Definition used by COBie2 queries the following IFC data types from an 
architectural model and/or its elements: 

- Owner History data 
- IFC Attributes 
- IFC Properties (standard IFC 2x3 and custom COBie2-required properties) 
- IFC Classification Reference data 
- IFC Type Product entities 
- IFC Zone assignments 
- IFC System assignments 
- Base quantities 
- Space containment relation 
- Space boundary relation 

All of these data types are available or can be created in ArchiCAD 17 using one or more of these functions: 
- Element Settings dialog boxes 
- the IFC Manager tool 
- IFC Translator settings used for IFC model export 

This chapter summarizes the data (required from a design application) to be provided in ArchiCAD 17 for use 
by the COBie2 spreadsheet worksheet. 

 

Figure 1   The worksheets of the COBie2 spreadsheet 
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Key to tables displayed in the following sections of this document: 

 COBie2 data taken directly from data that was input in ArchiCAD. In other words, the 
ArchiCAD and IFC data types corresponding to these COBie data must be set or created in 
the ArchiCAD model. 
 

 COBie2 data that are automatically extracted from the ArchiCAD model, project settings 
and their IFC export. In other words, these COBie data are set automatically in ArchiCAD; 
no extra data definition is required from the ArchiCAD user. 
 

  

Contact 
The COBie2 Contact worksheet summarizes the person and organization data of the project/model designer. 

 

Figure 2   Mapping between ArchiCAD model data and the COBie2 Contact worksheet data 

ArchiCAD project data must be assigned to correspond with the COBie2 items marked in green (the rest of 
the data are automatically extracted from the IFC model saved from ArchiCAD). 

The “Person” and “Organization” data can be entered in ArchiCAD’s IFC Options (File > File Special > IFC 2x3) 
dialog box at Owning User of Owner History. Both “Postal” and “Telecom” address types must be defined, but 
only once, as “Person” or as “Organization” “Address” data. 



7 
 

 

Figure 3   Contact data in ArchiCAD (Person and Organization) 
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Facility 
The COBie2 Facility worksheet summarizes the Facility (IfcBuilding), Project (IfcProject) and Site (IfcSite) data. 

 

Figure 4   Mapping between ArchiCAD model and the COBie2 Facility worksheet data 

The Facility data (including the Facility “Name”) can be defined as the attributes of the IfcProject, IfcSite and 
IfcBuilding IFC entities in the IFC Manager dialog (File > File Special > IFC 2x3). 

The “ProjectName” data of the Facility worksheet can be set in ArchiCAD at Project Info (File > Info) or as the 
“Name” attribute of the IfcProject in the IFC Manager. 
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Figure 5   Attributes of IfcProject, IfcSite and IfcBuilding entities required by COBie2 (IFC Manager) 

To set the Facility “Category”, define Classification Reference data in the IFC Manager. COBie requires 
IfcBuilding classification by the OmniClass table 11 called “Construction Entities by Function” in US or by the 
Uniclass system in UK. Both systems are available as built-in classification rules in ArchiCAD under the Apply 
Predefined Rule option in the IFC Manager. 



10 
 

 

Figure 6   COBie Facility Category set as Classification Reference data of IfcBuilding (IFC Manager) 

The COBie-required unit systems of the Facility can be set at the export options (IFC Translation Setup). There 
is a predefined settings package (so-called “IFC Translator” in ArchiCAD) which contains the export options 
(including the required length, area, volume, currency and time units) recommended for the COBie-required 
IFC export. It is called “Basic FM Handover View” IFC Translator (see chapter COBie2-enabled IFC Model 
Export). 
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Floor 
The COBie2 Floor worksheet summarizes data of the building stories (IfcBuildingStorey). 

 

Figure 7   Mapping between ArchiCAD model and the COBie2 Floor worksheet data 

The “Floors” are interpreted as Stories in the ArchiCAD project. The story names (COBie “Name”), the 
elevation (COBie “Elevation”) and the height (COBie “Height”) can be defined in the Story Settings dialog 
(Design > Story Settings). 

 

Figure 8   Story definition and its effect on the IFC model in ArchiCAD 

To set the Facility “Category”, define Classification Reference data in the IFC Manager. COBie requires 
IfcBuildingStorey classification by the OmniClass table 11 called “Construction Entities by Function” in US or 
by the Uniclass system in UK. Both systems are available as built-in classification rules in ArchiCAD under the 
Apply Predefined Rule option in the IFC Manager. 

Floor Category can be defined manually too. Apply the Create Property/Classification command to an 
IfcBuildingStorey item in the IFC Manager. The required classification “Name” and/or “ItemReference” data 
can be set in the Classification Reference dialog which opens by clicking the  button next to the name field 
of the new Classification Reference item. 

The “Description” attribute of an ArchiCAD Story (IfcBuildingStorey) can also be set via the IFC Manager. 
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Figure 9   ArchiCAD Story data required as COBie Floor data 

 

Figure 10   Manual method of Category definition in ArchiCAD 
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Space 
The COBie2 Space worksheet summarizes data of the Spaces (IfcSpace) of the project. 

 

Figure 11   Mapping between ArchiCAD model and the COBie2 Space worksheet data 

The “Spaces” are interpreted as Zones (IfcSpaces) in the ArchiCAD project. Thus, the COBie2-required data 
can be set in ArchiCAD Zone Settings. IFC data can be set using the Manage IFC Properties option (Tags and 
Categories tab). 

“Name” and “Description” COBie2 items are derived from the “No.” and the “Zone Name” attributes of the 
ArchiCAD Zone. To set the Space “Category”, define Classification Reference data. COBie requires IfcSpace 
classification by the OmniClass table 13 called “Space by Function” in US or by the Uniclass system in UK. 
Both systems are available as built-in classification rules in ArchiCAD under the Apply Predefined Rule option. 

Note Each Space has to have a unique COBie “Name” (ArchiCAD Zone “No.”). The Zone “No.” can be 
assigned or edited in the Zone Settings dialog box (Name and Positioning panel). 

The COBie “RoomTag” data can be defined as custom IFC property in an ArchiCAD model. Although any 
custom IFC property can be defined with the Create Property/Classification tool, the COBie-required 
properties are available when using an IFC scheme template called “COBie2.xml” (available in the ArchiCAD’s 
Default/ IFC Schemes folder; see COBie2 Scheme Template). 

 

Figure 12   Space data in ArchiCAD  
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Zone 
The COBie2 Zone worksheet summarizes the sets of spaces sharing a specific attribute in the project. In other 
words, it summarizes the data of the groups (IfcZones) of COBie Spaces (IfcSpaces). 

 

Figure 13   Mapping between ArchiCAD model and the COBie2 Zone worksheet data 

The “Zones” are interpreted as IFC Zone Assignment (IfcZone) entities in the ArchiCAD project. An IfcZone 
entity is a group of ArchiCAD Zone (IfcSpace) entities. Assignments (including IFC Zone) can be defined and 
managed only in the IFC Manager, so their COBie2-requested data can be defined with the IFC Manager too. 

A COBie “Zone” (IfcZone) can be defined with the New command by applying it on the “IFC Zones” member 
of the “Assignments” tree. The “Name” attribute of the new IFC Zone defines the COBie “Name” data. Drag 
and drop the proper IfcSpace (ArchiCAD Zones) members from the IFC model hierarchy tree of the IFC 
Manager to the “New Relation” folder of the new IFC Zone entity. 

 

Figure 14   COBie2 Zone (IFC Zone) definition in the IFC Manager 
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To set the Zone “Category”, define Classification Reference data. COBie requires IfcZone classification by the 
OmniClass table 13 called “Space by Function” in US or by the Uniclass system in UK. Both systems are 
available as built-in classification rules in ArchiCAD under the Apply Predefined Rule option. 

If other Zone “Category” definitions are required by the COBie documentation, apply the Create 
Property/Classification command to an IfcZone item in the IFC Manager. As an example, the definition of a 
“ZoneType” Classification Reference data with one of the following values for the “Name” attribute can be 
seen in the following figure: 

- Circulation Zone 
- Lighting Zone 
- Fire Alarm Zone 
- Historical Preservation Zone 
- Occupancy Zone 
- Ventilation Zone 

 

Figure 15   Custom (non-standard) Zone Category definition in the IFC Manager 
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Type 
COBie2 Type worksheet summarizes the types of equipment and products. 

 

Figure 16   Mapping between ArchiCAD model and the COBie2 Type worksheet data 

The “Types” are interpreted as IFC Type Product entities in the ArchiCAD project. IFC Type Products and their 
COBie2-requested data can be defined in the IFC Manager only. ArchiCAD automatically generates IFC Type 
Product entities for all ArchiCAD element types. The following table shows some naming examples of the 
automatically generated IFC Type Products. Of course, the default values of the names can be modified 
manually with the IFC Manager. 

 

Figure 17   The default naming rule examples of IFC Type Product entities 
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For some object types, ArchiCAD considers other rules to define their IFC Type Product. For example, two 
windows defined from the same Library Part will be grouped in two separate IFC Type Products, if their size 
or their operation type (for example: “single swing right” or “single swing left”) differs. 

To manage the required IFC attributes, properties and classification reference (COBie Category) items of an 
IFC Type Product (for example the properties of an IfcWindowStyle assigned to identical IfcWindow objects), 
first set the type object to editable with the Edit/New Type tool, and then define, set or modify the COBie-
required properties. 

Note Each Type has to have a unique COBie “Name” (“Name” attribute of IFC Type Product). When a 
Component is defined, this “Name” attribute is automatically generated based on the rules described 
above. If needed (e.g. if the automatically generated “Name” attribute is not unique), it can be 
modified in IFC Manager, after you have made this field editable. 

If an IFC Type Product is editable, the following functions are available for it: 

- renaming (modification of the “Name” attribute); 
- setting, defining (new) or modifying IFC properties and classifications; 
- deleting it by moving its all members (for example Windows) to another IFC Type Product (but of the 

same type: for example IfcWindowStyle); 
- a member can be removed from the current IFC Type Product by moving it into a totally new or a 

currently available (but same type) IFC Type Product. 

To make all COBie2-required IFC Properties available for the Type elements in the IFC Manager, use the 
“COBie2.xml” scheme in the ArchiCAD project (see COBie2 Scheme Template). 

To set the Type “Category”, define Classification Reference data in the IFC Manager. COBie requires 
IfcTypeProduct classification by the OmniClass table 21 called “Elements” in US or by the Uniclass system in 
UK. Both systems are available as built-in classification rules in ArchiCAD under the Apply Predefined Rule 
option. 

 

Figure 18   COBie-required IFC properties defined for an IFC Type Product entity 
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The COBie-required duration units can be set at the export options (IFC Translation Setup). There is a 
predefined settings package (so-called “IFC Translator” in ArchiCAD) which contains the export options 
(including the required time units) recommended for the COBie-required IFC export. It is called “Basic FM 
Handover View” IFC Translator (see chapter COBie2-enabled IFC Model Export). 

 

Component 
The COBie2 Component worksheet summarizes the individually named items of the project. 

 

Figure 19   Mapping between ArchiCAD model and the COBie2 Component worksheet data 

The “Name” data are derived from the ArchiCAD “ID” of the element, so you can set them in the element 
Settings dialogs. 

Note Each Component has to have a unique COBie “Name” (ArchiCAD “ID”). If you did not assign unique 
(different) ID’s to your ArchiCAD elements, you can do so at any time, for example using the Element 
ID Manager function (Document > Schedules and Lists). 

The “Space” data describes the ArchiCAD Zone (IfcSpace) assigned to a component. This data is automatically 
calculated, if the IFC export uses the Space containment and the IFC Space boundaries functions (see chapter 
COBie2-enabled IFC Model Export). 

To make all COBie2-required IFC properties available for the Component elements in the element Settings 
dialog (Tags and Categories > Manage IFC Properties), use the “COBie2.xml” scheme in the ArchiCAD project 
(see COBie2 Scheme Template). 

To set the Component “Category”, define Classification Reference data in the IFC Manager. COBie requires 
classification of Components (ArchiCAD elements) by the OmniClass table 21 called “Elements” in US or by 
the Uniclass system in UK. Both systems are available as built-in classification rules in ArchiCAD under the 
Apply Predefined Rule option. 
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Figure 20   COBie-required IFC property definition in an element Settings dialog 
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System 
The COBie2 System worksheet summarizes the sets of Components providing a service. In other words, it 
summarizes the data of the systems (IfcSystem) of the project elements. 

 

Figure 21   Mapping between ArchiCAD model and the COBie2 System worksheet data 

The “Systems” are interpreted as IFC System Assignment entities (IfcSystem) in the ArchiCAD project. 
Assignments (including IFC System) can be defined and managed only in the IFC Manager, so their COBie2-
requested data can be defined with the IFC Manager too. 

A COBie “System” (IfcSystem) can be defined with the New command by applying it on the “IFC Systems” 
member of the “Assignments” tree. The “Name” attribute of the new IFC System defines the COBie “Name” 
data. Drag and drop the proper ArchiCAD element (COBie Component) members from the IFC model 
hierarchy tree of the IFC Manager to the “New Relation” folder of the new IFC System entity. 

To set the System “Category”, define Classification Reference data. COBie requires IfcSystem classification by 
the OmniClass table 21 called “Elements” in US or by the Uniclass system in UK. Both systems are available as 
built-in classification rules in ArchiCAD under the Apply Predefined Rule option. 
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Figure 22  IFC System definition in the IFC Manager 

MEP Systems defined with the GRAPHISOFT MEP Modeler Add-On can be also handled as IfcSystem inside an 
ArchiCAD project. Just create a new IfcSystem (as mentioned above) and choose the predefined MEP System 
name from the list available  (see the following figure). 

If an IFC model (for example exported by an MEP application) merged to the current ArchiCAD project 
contains IfcSystems, you can also manage them and their properties in the IFC Manager. 

 

Figure 23   Conversion of a MEP Modeler System to an IFC System 

  

http://www.graphisoft.com/archicad/mep_modeler/
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Document / Attribute / Coordinate / PickLists 
Data are extracted automatically from the IFC model exported by ArchiCAD. 

 

Assembly / Connection / Spare / Resource / Job / Impact / Issue 
These data types are not requested from a design application by the COBie2 rules, and they are not available 
in ArchiCAD projects either. The table contents should be manually filled out in the spreadsheet, if they are 
required. 

 

 

COBie2 Scheme Template 
 

To make all COBie2-required custom IFC properties available for the COBie Space, Type and Component 
entities in the Setting Dialogs and in the IFC Manager, load the “COBie2.xml” scheme template file into the 
ArchiCAD project: use the Merge command for the .xml file in the IFC Scheme Setup dialog (File > File Special 
> IFC 2x3). 

 

Figure 24   COBie-required properties loaded as a scheme template 
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COBie2-enabled IFC Model Export 
 

COBie-required IFC model/file can be exported easily by using the export set (so-called “IFC Translator”) 
optimized for the Basic FM Handover View. Just use the Save as command (File menu) together with the 
translator called “Basic FM Handover View” from either a Floor Plan or a 3D window. 

 

Figure 25   IFC model export based on Basic FM Handover View (COBie) 

The steps of IFC model export: 

1. Element filtering possibilities for the export: 
- Selected elements only (available only if elements have been selected): 

elements selected in the current view (the view that was open when you issued the export 
command) will be exported. 

- Entire project: 
entire model (regardless of any selection, and regardless of the elements’ show/hide status) will 
be exported. 

- Visible elements (on all stories): 
the visible elements in the current view will be exported, regardless of any selection. “Visible” 
means all elements that are set to be displayed (due to layer settings, model view options, 
partial structure display, etc.). 
Note If you issue the export command from Floor Plan view (“Visible elements (on all 

stories)”), this choice includes all elements currently displayed on every story of the 
project. 

- All elements on current story (available only if Floor Plan is open): 
all elements (regardless of any selection, and regardless of the elements’ show/hide status) on 
the current story of the Floor Plan will be exported. 

- Visible elements on current story (available only if Floor Plan is open): 
all elements (regardless of any selection) that are visible on the current story of the Floor Plan 
will be exported. 
 

Note If you choose “Visible elements,” make sure that ArchiCAD Zones are set to be displayed in 
the current view. For example, if you are saving from the 3D window, make sure that Zones 
are “on” in the Filter and Cut Elements in 3D dialog box (View > Elements in 3D View). 
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2. Choose the “Basic FM Handover View” Translator, in which export settings are fine-tuned for the FM 
Handover requirements. 
 
Note The meaning of the “Derived model data to export” options (IFC Translation Setup > Export 
Options): 

- Space containment: 
It exports the relationship between ArchiCAD Zones (IfcSpaces) and their contained 
Object (Furnishing, Mechanical (HVAC), etc.) and Morph elements. “Contained” means 
that the middle point of an Object or Morph is within an ArchiCAD Zone in the 3D space. 
This option is required for exporting COBie “Space” data of the Component worksheet. 

- Base quantities (length, area and volume): 
It exports elements’ base quantities required by COBie2. 

- IFC Space boundaries with tolerance between Zones [mm]: 
It exports the logical connection between ArchiCAD Zones (IfcSpace) and the building 
elements that enclose them. The “tolerance between Zones” means the maximum 
distance between neighboring ArchiCAD Zones (for example, the thickest wall/slab) in 
mm. This option is required for exporting COBie “Space” data of the Component 
worksheet. 

 

Figure 26   Major export options of the “Basic FM Handover View” (COBie) IFC translator 

3. Define file name. 
 

4. Choose the file format of the IFC export. Choose .IFC or .IFCXML depending on the file support of the 
COBie2 spreadsheet converter programs (see the How to Create a COBie2 Spreadsheet chapter). 
 

5. Click Save.  
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How to Create a COBie2 Spreadsheet 
 

An external application is needed to convert an ArchiCAD IFC file to an XLS/XML-type COBie2 spreadsheet 
format. 

The IFC, IFCXML and COBie2 spreadsheet formats for the IFC 2x3 Basic FM Handover MVD do capture the 
same information content and can be transformed forth and back across the different formats. A number of 
dedicated tools can be used to execute the transformations, such as the free COBie Toolkit application, 
developed by Engineer Research and Development Center (ERDC). 

ERDC COBie Toolkit, developed for the COBie FM Handover project, includes the transformer tool and the 
configurations to map IFC data to COBie2. The application also checks for any missing items in your IFC 
model. The conversion can be done in two easy steps (1. IFC file selection and 2. COBie output file type 
selection). 

 

Figure 27   The steps of IFC to COBie conversion 

Hint COBie Toolkit is a free tool and can be downloaded from here or from the following website: 

 https://github.com/opensourceBIM/COBie-plugins 

http://projects.buildingsmartalliance.org/files/?artifact_id=5466
https://github.com/opensourceBIM/COBie-plugins
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